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Abstract: What most sensed about Technical High School (known as SMK) students is their lack of 

analytical capability. As their nature of academic orientation is aimed at job fullfillment, the 

students are enhanced to follow Standard Operational Procedure (SOP) without questioning 

why such SOP should be followed. As for automotive students, they simply following the steps 

of doing things related to any activities of repairing car and other mechanical work required 

just because the job will be done well when the procedure completed.  

This kind of mentality “following order or SOP” fits to those who only want to be workers not 

the men who take higher responsibilities. The progress of automotive technology demand on 
understanding the concept of how some system used in a car. Failure to comprehend to concept 

will jeopardize the performance of a car. At the same time, the progress of automotive 

technology is also propelled by the progress of information technology which provides more 

open resources that can be used to promote the quality of instuctional process.  

Realizing that having analysis compentence is terribly important to run higher responsibilites 

and continuing education to a university, automotive students need to learn how to analyze. To 

promote this, teacher can use some automotive movies or animations and then chop them into 

many fragments related to instructional objectives. The way how the teachers arrange and 

present the fragments can be combined into power point and ended up with an interactive test 

with different model of methods, strategies, or techniques. Movies, movie cutter application, 

interactive test Creator ,  paint into fragments can be obtained freely from the internet.  
The using of movie fragments integrated into power point, arrange the fragment into various 

strategies, ended up with interactive test will likely focus the students into more realistic 

understanding toward the concept taught in the classroom. In return the students will be 

accustomed to analyze each fragment to building comprehension of concept underlying the 

skill required in automotive work. 

Key Words:  Automotive Students, Movie Fragment, Movie Cutter, Power Point, Paint,  Interactive Test 

Creator , Instructional Strategies 
 

A. Introduction 

Learning achievement has always been 

becoming a dinamics issue as the effort of 

improvement keeps changing to facing 

more challenges. The changing of 

curriculum proves that learning 

achievement made by previous ones has 

not yet reached the satisfaction of three 

domains “Cognitive, Psycomo-toric, and 

Afective”. Many students got high score 

but they are lack of good character, they 

can’t even understand how could they get 

the score since they felt that they didn’t 

study hard. Teachers are demanded and 

made to expose good achievement of  the 

students by the system. The application of 

Minimum Passing Grade (known as 

KKM) in each subjects often neglec-ting 

the process and circumcising of 

students’potential to do  more in learning. 

  

SMK students suffer most from this 

situation. They mostly leaded to learn how 

to achieve psycomotoric domain rather 

than the other two domains. In automotive 

vocation, the accentuation of 

psycomotoric domain exist due to the 

implementation of SOP during repairing 

exercise to acquisite the auto-motive 

competence. This is obvious when the 
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nature of SMK edu-cation is to fill job 

vacancies. Admitted or not, this notion has 

brought the tea-chers to neglect deep 

cognitive skill achievement such as 

analysis capaility. Having the thought that 

psycomotoric domain is more important 

than other two domains, teachers are lack 

of implementing various strategies to 

promote analysis capability.  

 

There are various kind of instructional 

strategies. Once it was said by our maestro 

of education, Dewantara, (1977:28) there 

are many ways of instructional, but 

basically they can be divided as follows: 

1) voorbeld (demonstrating or exposing 

sample); 2) gewoontevorming 

(habituation); 3) leering (teaching); 4) 

regeering en tucht (instruction, forcing, 

and punishment; 5) zelfbeheersching, zelf 

discipline (self behaviour, self discipline); 

6) beleving, (experiencing both physics 

and soul). Almost all the instrutional 

strategies above have been applied by 

vocational teachers. Yet the students 

achievement remains unsatisfaction in 

term of anaylisis capability. As the 

progress of information technology 

rapidly overgrowing the teachers 

competence, these six basic instructio-nal 

strategies proposed by Dewantara are less 

effective when current instructional 

process fail to associate them with the 

existence of information technology.  

 

Learning happens to everyone. Learn-ing 

occurs when experience cause a relatively 

permanent change in indivi-dual’s 

knowledge or behavior.. To qua-lify as 

learning, this change must be brought 

about by experience-by the interaction of  

a person with his or her environment 

(Woolfolk, 2004:198). The word 

environment can be accomo-dated as an 

instructional condition orchestrated by 

teachers in a systematic ways. It is so 

because instructional activities cover 

many components and then so called as an 

instructional sys-tem. One of the 

components is instruc-tional media. The 

implemention of well organized media 

will promote learning optimally and lead 

to the succesfullness of achieving the 

highest level of each learning domain.  

 

Instructional media used to teaching 

automotive students in order to achieve 

anaylisis capability should be attractive in 

term of focusing their attention as learning 

progress. As the students learn, they will 

likely to operate all their senses as an 

attempt to compre-hend the concept or 

meaning conveyed during instructional 

delivery. To do so, the media must catch 

their eyes, ear, mind, and emotion. 

Internet provides free movies in many 

extension, movie cutter, quiz maker, while 

Microsoft Office provides many fitures 

such power point and paint which can be 

used to help building the media. It is okay 

to build protoype media using the those 

application but then some revi-sion can be 

done later as Dick and Carey, 2005:238) 

say that if one made open selections of 

media formats and ideal delivery system, 

however, the likelihood is high that 

spesifications will be revised during 

materials deve-lopment process. 

 

The notion of this article is to provide 

some deep thoughts  related to some 

efforts necessary to create an instruc-

tional system by taking advantage of 

many open resources from the internet to 

constructing some media using movies, 

video cutter, paint application, power 

point application, and quiz maker 

application in automotive course. The 

media will eventually lead to analysis 

capability development. 

 

B. Analytical Capability of Automo-tive 

Students 

Bloom’s theory about learning taxono-my 

has been embraced by educators for years 

that the taxonomy of learning s classified 
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into cognitive, psycomotoric, and 

affective. Each domain consist of some 

levels. Later on five categories of learning 

outcomes. The performance that may be 

observed as learning out-comes are 

considered to be made possi-ble by 

internally stored states of human learners, 

called capabilities. (Gagne et al, 1992:43). 

Cognitive domain is derivated to 

intellectual skills which enable individuals 

to interact with their environment in term 

of symbols or conceptualizations.  

 

Later on some changes proposed by 

Angderson et al (2001:31) cognitive 

domain related to intellectual skills consist 

of six level, they are: 1) know-ing; 2) 

understanding; 3) applying; 4) analysing; 

5) evaluating; and 6) creat-ing. Analytical 

capability is at the fourth level of 

cognitive domain. Most odf automotive 

students can only reach the third level. 

That when they got trouble in diagnosis of 

an engine prob-lems and other light 

vehicle problems. People come to 

automotive repairshop to repair their 

troubled vehicles which means as future 

automotive mechanics, automotive 

students need to have an analysis 

capability.  

 

Troubled vehicles can be in many form. 

Proper troubleshooting will eliminate 

potential issues that aren't the real problem 

and point you in the right direction. 

There's no bigger waste of money than 

repairing or replacing an auto part only to 

find out it wasn't the problem...They can 

be basic trouble shooting, electrical 

problem, and OBD (On Board 

Diagnostics) Evaluation (Wright, 2014:1). 

Other form can be  such as: 1) poor engine 

performance; 2) fuel consumptive; 3) oil 

consumptive; 4) overheating temperature; 

5) poor baterray performance; 6) poor 

lighting system performance; 7) poor 

brake system performance; 8) poor power 

train performance; 9) running left tyre 

while driving; 10) excessive tolerance of 

steering system, and many others. In oder 

to be able to solve the problem, the 

students need to do some diagnostic based 

on some observation and test conducted 

on the vehicles. Once the data collected 

from the observation considered enough, 

the students will have to analyze the data 

to precisely locate or determine what 

actions should be taken to overcome the 

trouble. 

 

C. Some Applications to Build 

Instructional Media on The Basis of 

Movie, Power Point, and Interactive 

Test Creator  

There are so many applications and 

movies available on the internet which can 

be obtained for free. Some links provide 

animation or video which can be 

downloaded  by the automotive students 

and teachers. Simply typing “How an 

engine car work” on address bar will lead 

the internet users to many sites or links  

provide articles, videos, movies related to 

the key word. The result comes up when 

the key word “How an engine car”typed 

and the enter key hit by the users is 

https://www.google.com/search?q=how+a

n+engine+car+work&ie=utf-8&oe=utf-

8&aq=t&rls=org.mozilla: 

id:official&client=firefox-a&channel 

=fflb. Users will find more.  

 

Let us try http://auto.howstuffworks. 

com/engine.htm. Users will be exposed to 

many links related to they key word. 

Automotive students and teacher can 

download as many as they can from the 

link. Various file with different exten-sion 

can be found and downloaded. Once some 

movies needed to build an instructional 

media acquired, the movies then, 

sometimes, need to be converted to other 

extension so that they can be compatible 

to work with other applications. To 

convert the movies, automotive students 

and tea-chers can download from the 

https://www.google.com/search?q=how+an+engine+car+work&ie=utf-8&oe=utf-8&aq=t&rls=org.mozilla:%20id:official&client=firefox-a&channel%20=fflb
https://www.google.com/search?q=how+an+engine+car+work&ie=utf-8&oe=utf-8&aq=t&rls=org.mozilla:%20id:official&client=firefox-a&channel%20=fflb
https://www.google.com/search?q=how+an+engine+car+work&ie=utf-8&oe=utf-8&aq=t&rls=org.mozilla:%20id:official&client=firefox-a&channel%20=fflb
https://www.google.com/search?q=how+an+engine+car+work&ie=utf-8&oe=utf-8&aq=t&rls=org.mozilla:%20id:official&client=firefox-a&channel%20=fflb
https://www.google.com/search?q=how+an+engine+car+work&ie=utf-8&oe=utf-8&aq=t&rls=org.mozilla:%20id:official&client=firefox-a&channel%20=fflb


ISSN 2089 -3345 – Vol. 3 No. 1,  April 2014  37 

internet by typing key word “Free Video 

Con-verter” on the address bar and then 

hit the enter key. An example of free 

video converter is available here 

http://www.freemake.com/free_video_con

verter/.  

 

Another application required to build 

instructional media on the basis of movie 

is video cutter. The using of movie as an 

instructional media can be fun and 

attractive but it is not necessary to watch a 

movie all along during instructional 

process. Not only wasting time but also 

less effective to achieving instructional 

objectives. The movie need to be chopped 

down into shorter durations or fragments 

which have something to do with the 

instructional objectives. It will be much 

better when the fragments exposed to the 

students one after another based on the 

objective formulated at the lesson plan. 

The presence of movie fragments will 

likely focus the student’s attention and 

bring their imagination deeper to visualize 

difficult concept required to master.  

To download video cutter with many type 

and fitures can be downloaded from the 

internet. There are also some video cuttter 

application which can cut the video into 

pieces and at the same time convert the 

file extension into different type as the 

users want it to be. One type of video 

cutter can be found here www.vcd-

cutter.com. This is free software but 

require an internet connection when 

installing to the computer.  

 

Instructional process has always to be 

ended by an evaluation to make sure 

whether the objectives formulated in the 

lesson plan are achieved by the students. 

Test, whether they are multi-ple choice, 

limmitted essay, or match-ing etc can be 

built by using many applications, one of 

them is wonder-share quiz maker atau 

http://free-

quizmaker.software.informer.com/6.1/. 

Test produced by this application can be 

an interactive test to be integrated with 

various application media. There are nine 

events of instruction proposed by Gagne 

et al (1992:190) they are: 1) gaining 

attention; 2) informing learner of the 

objectives; 3) stimulating recall of 

prerequisite learning; 4) presenting the 

stimulus material; 5) providing learning 

guidance; 6) eliciting the per-formance; 7) 

providing feedback about performance 

correctness; 8) assessing the performance; 

9) enhancing reten-tion and transfer. The 

eight event is facilitated by interactive 

test.  

 

The last two applications require to build 

instructional media on the basis of movie 

fragment are power point and paint 

application of Microsoft office. These 

fitures are built in Microsoft office to 

support any paper work. Power point is 

very familiar for the students and the 

teachers. The problem is that most of 

automotive students and teachers haven’t 

optimized the facilities in these fitures. 

Most of them can only operate power 

point and paint applica-tion in very simple 

manner which less effective to attract 

students attention when the instruction 

progres-sing. Power point is equipped 

with master slide fiture which can be 

organi-zed to create navigation buttons so 

that the presentation delivered will be 

easily handled. When some students 

asking to looking back some slides, the 

teacher can locate the slide easily simply 

by clicking the navigation button. Paint 

application create jpg file from the 

computer screen, even when the screen 

show a movie. 

 

D. How to Build Instructional Media on 

The Basis of Movie, Power Point, 

and Interactive Test Creator  

1. How to Use Video Cutter 

The first step taken is to choose some 

automotive movies. They can be fuel 

http://www.freemake.com/free_video_converter/
http://www.freemake.com/free_video_converter/
http://www.vcd-cutter.com/
http://www.vcd-cutter.com/
http://free-quizmaker.software.informer.com/6.1/
http://free-quizmaker.software.informer.com/6.1/
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system, ignition system, starting sys-tem, 

transmision system, differential system, 

brake system etc. It is preferable the 

extension of the movie is MPG or MPEG. 

If the extension is different, the movies 

can converted to MPG or MPEG by using 

video converter.  

VCD Cutter is a very easy to use. Free 

VCD Cutter can cut clips from any of 

your VCD in simple 3 steps.  It maintains 

the VCD quality so you can enjoy the 

final clipped video without any quality 

loss.  

 

 

 

To cut clips from your VCD you need to 

follow simple steps: 1) Open the 

VCD(DAT) file by clicking open; 2) Mark 

start and end of VCD Clip to be made; 3) 

Click Save and choose the output 

filename; 5) Done. Automotive teachers 

can choose which part of the movie will 

be taken as part of the media organized by 

power point through hiperlink facility 

connected to the navigation button of the 

power point. 

 

2. How to Create Navigation Button, 

Hiperlink, dan Slide Master of The 

Power Point 

Automotive teachers can add buttons to 

their presentations. The main reason for 

doing so is when the teachers want a 

presentation that will be viewed when 

they're not there. For example, they may 

want to create an educational pre-

sentation for the students. The students 

can then navigate through their slides in 

their own time, by clicking the buttons. 

When the buttons are clicked they will 

perform an action, such as advancing to 

the next slide.  Grouping Power Point 

action buttons into a navigation toolbar 

makes a Power Point slide show easy to 

navigate. The bottom of the Power Point 

Slide Master is a good place to add 

navigation. Beginning, Backward 

(Previous), For-ward (Next), and Ending 

buttons make navigation a snap, but 
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teachers can include any buttons teachers 

want. 

 

To create a navigation toolbar that appears 

on every slide, follow these steps:  

1) Switch to Slide Master View 

From the View tab on the Ribbon, click 

the Slide Master button in the Presen-

tation Views group. 

 

 
 

2) Create the action buttons that you want 

to include. 

Open the Insert tab on the Ribbon and 

click the More button in the Shapes group 

to reveal the Shapes gallery. Click the 

button for the action button shape that you 

want to create. Point to where you want 

the upper-left corner of the button. Then 

click and drag to where you want the 

lower-right corner of the button. When 

you release the mouse button, the Action 

Settings dialog box appears. 
 

3) Return to Normal View 

Click the Normal View button or click the 

Normal button in the Presentation Views 

group on the View tab. The buttons that 

you created appear on every slide in your 

presentation. For more information 

automotive teachers can visit this site for 

free http://www.homeandlearn.co.uk/-

powerpoint/powerpoint_p4s4.html. 
 

In Microsoft Office PowerPoint 2007, a 

hyperlink is a connection from one sli-de 

to another slide in the same presen-tation 

(such as a hyperlink to a custom show) or 

to a slide in another presen-tation, an e-

mail address, a Web page, or a file. You 

can create a hyperlink from text or from 

an object, such as a picture, graph, shape, 

or WordArt. Fur-ther information about 

making hiperlink can be found here  

http://office.microsoft.com/en-

us/powerpoint-help/create-a-hyperlink-

HA010021479.aspx 
 

A slide master is the top slide in a hie-

rarchy of slides that stores information 

about the theme and slide layouts of a 

presentation, including the background, 

color, fonts, effects, placeholder sizes, and 

positioning. Every presentation contains at 

least one slide master. The key benefit to 

using slide masters is that you can make 

universal style changes to every slide in 

your presenta-tion, including ones added 

later to the presentation. When you use a 

slide master, you save time because you 

don't have to type the same information on 

more than one slide. The slide master 

especially comes in handy when you have 

extremely long presentations with lots of 

slides. 
 

Because slide masters affect the look of 

your entire presentation, when you create 

and edit a slide master or corresponding 

layouts, you work in Slide Master view.  

 

http://www.homeandlearn.co.uk/-powerpoint/powerpoint_p4s4.html
http://www.homeandlearn.co.uk/-powerpoint/powerpoint_p4s4.html
http://office.microsoft.com/en-us/powerpoint-help/create-a-hyperlink-HA010021479.aspx
http://office.microsoft.com/en-us/powerpoint-help/create-a-hyperlink-HA010021479.aspx
http://office.microsoft.com/en-us/powerpoint-help/create-a-hyperlink-HA010021479.aspx
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Automotive teachers can also make 

multiple slide masters in a presentation. 

When they want a presentation to contain 

two or more different styles or themes 

(such as backgrounds, colors, fonts, and 

effects), they need to insert a slide master 

for each different theme.  For example, in 

the image that follows, there are two slide 

masters as you would see them in Slide 

Master view. Each slide master has a 

different theme applied to it. Each slide 

master owns the layouts beneath it. Any 

modifications or customizations made to 

those layouts belong to the associa-ted 

slide master. All presentations have a slide 
master, whether you modify it directly or not. 

 

Slide master allows presentation easily 

connected to the students interest and 

request. More information about creating 

good slide master can be freely found 

here: 

 http://office.microsoft.com/en-

us/powerpoint-help/create-and-customize-

a-slide-master-HA010078011.aspx 

 

3. How to Build Interactive Tests 

Open wondershare quizcreator and create 

a new quiz. The application will lead us 

in. 

 

 

The next view will be as follows and we can 

chose what type of test will be. 

 

 

For more information  about building 

interactive quiz, this link  can be 

http://support.wondershare.com/quizcreat

or/  visited by autmotive tea-chers as well 

as downloading the master. 

 

When all movie fragments linked to the 

navigation button in power point 

organized by slide master, teacher will 

likely have a  more applicable movie 

fragments, power point, and interactive 

testas instructional media. The buttons can 

be organized as many as meeting should 

be held in a semester. Dummy media 

consists of these applications is available 

here  

http://www.4shared.com/rar/r2aCMdhYce

/dummy.html 

 E. Various Strategy Associated with 

Instructional Media on The Basis of 

Movie, Power Point, and Interactive 

Test Creator  

 

The education reformation has put 

students as the subject of instruction. 

Teachers merely act as facilitators rather 

than a learning resource. At this point, the 

instruction stands on the basis of students 

centered. All efforts conducted by 

teachers are to stimulate, promote 

learning. This point of view is inspired by 

contructivism learning theory. Various 

approach/model/ stra-tegies/technique can 

be integrated with the instructional media 

on the basis of movie, power point and 

interactive test creator.  

 

http://office.microsoft.com/en-us/powerpoint-help/create-and-customize-a-slide-master-HA010078011.aspx
http://office.microsoft.com/en-us/powerpoint-help/create-and-customize-a-slide-master-HA010078011.aspx
http://office.microsoft.com/en-us/powerpoint-help/create-and-customize-a-slide-master-HA010078011.aspx
http://support.wondershare.com/quizcreator/
http://support.wondershare.com/quizcreator/
http://www.4shared.com/rar/r2aCMdhYce/dummy.html
http://www.4shared.com/rar/r2aCMdhYce/dummy.html
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The main proposition of constructivism is 

that learning means constructing, creating, 

inventing, and developing our own 

knowledge. Others can give us 

information, we can find information in 

books, and we can get information from 

the media, but as important as information 

is-and it is very important-receiving it, 

getting it, and hearing it does not really 

necessarily equal learning (Marlowe and 

Page, 1998:10) 

 

1. Inquiry Strategy 

Inquiry learning provides opportunities for 

students to experience and acquire 

processes through which they can gather 

information about the world. This requires 

a high level of interaction among the 

learner, the teacher, the area of study, 

available resources, and the learning 

environment.  

 

Students become actively involved in the 

learning process as they: 1) act upon their 

curiosity and interests; 2) develop 

questions; 3) think their way through 

controversies or dilemmas;  

look at problems analytically; 4) inqui-re 

into their preconceptions and what they 

already know; 5) develop, clarify, and test 

hypotheses; and, 6) draw infe-rences and 

generate possible solutions.  
 

Six points of ativities during inqury 

learning absolutely can be facilitated by 

the using the media on the basis of movie, 

power point, and interactive test at the end 

of each presentation. 

 

2. Cooperative Strategy 

Dozens of studies have demonstrated that 

when students are allowed to work 

together, they experience an increase in a 

variety of social skills; students become 

more able to solve the problem which 

demand cooperation for a solution, better 

able to take the role of the other, and are 

generally more cooperative on a variety of 

measures, such as willingness to help and 

reward others, (Kagan, 1999:3.2) 

 

When a slide consist of movie fragment 

related to a material given during 

instructional seems to be difficult, it will 

be more reasonable when the materials 

worked by grouping the students. Thus the 

presentation will guide the students 

among the group to get through the work.   

 

Beside those two strategies integrated 

with the media on the basis of movie, 

power point, and interactive test, there are 

still many others which can be used also. 

They are: problem solving, con-textual 

teaching and learning, even almost every 

strategy and technique can be integrated. 

Just make sure the presentation goes along 

with the various strategies potentially 

used.  

 

F. Conclusion and Suggestion 

1. Conclusion 

Sophisticated instructional media will not 

make any difference toward lear-ning 

achievement in term of analysis capability 

when the instruction sintax ignores nine 

events of instruction. It is not about the 

technology and the faci-lity but rather than 

how the automotive teacher organize the 

facilities to promote learning so that 

automotive student will be able to achieve 

analysis capability. The sequence of how 

the movie fragments arranged, presented, 

and then how the automotive students 

given some time to dig what concept lies 

between will stimulate and coore-late the 

fenomena delivered by the fragment and 

eventually lead to more analytical 

automotive learning process. 

 

2. Suggestion 

Some suggestions to follow are: 

1) Download all applications as they are 

shown on the link and start to learn 

how to construct instruction media on 
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the basis of movie, power point, and 

interactive test at the end of each 

presentation. 

2) The sequence of movie fragment 

organized by hiperlink and slide master 

of powerpoint has to promote 

constructivism learning theory 

3) Provide automotive student’s work-

sheet to enhance their concept 

understanding 

4) Test given at the end of meeting should 

be clarified to maintain their 

motivation that their effort is taken into 

account. 
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